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	 1	 Important Safety 
		  Information

Read this manual carefully before using the Datalink 7 diagnostic software. 
Datalink 7 is intended for use by professional technicians who have a 
thorough understanding of the Proheat X30, X45 Plus and M-Series G-II 
PCM heaters. This understanding is essential for an accurate, reliable and 
safe use of Datalink 7.

It is the users responsibility to be knowledgeable of the heater being 
diagnosed. Always use the applicable service methods provided by 
Proheat to ensure there is no risk to personal safety, the safety of others, 
and to prevent damage to the heater being diagnosed.

The symbols below are used throughout this publication to alert you to 
potential hazards involved with the operation and installation of this product. 
Observe these warnings and notices carefully. The safety alerts alone 
cannot eliminate hazards; strict compliance with any special instructions 
during installation, operation, and maintenance, along with common sense 
operation, are important measures to prevent hazardous situations.

	 1.1	 Explanation of symbols

DANGER!
Safety instruction: Indicates a hazardous situation that, if not avoided, 
will result in death or serious injury.

WARNING!
Safety instruction: Indicates a hazardous situation that, if not avoided, 
could result in death or serious injury.

CAUTION!
Safety instruction: Indicates a hazardous situation that, if not avoided, 
could result in minor or moderate injury.

NOTICE!
Indicates a situation that, if not avoided, can result in property damage.

NOTE
Supplementary information for operating the product.
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	 2	 Proheat Control Module 
		  (PCM) Type
	 2.1	 X30 PCM identification

NOTICE!
The information contained in this manual is only for use with the  
X30, X45 Plus or M-Series G-II PCM.

Please refer to the X30 service manual at www.proheat.com for additional 
information.

Figure 2-1. X30 PCM identification.
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	 2.2	 X45 Plus PCM identification

NOTICE!
The information contained in this manual is only for use with the  
X30, X45 Plus or M-Series G-II PCM.

Please refer to the X45 Plus service manual at www.proheat.com for 
additional information.

Figure 2-2. X45 Plus PCM identification.
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	 2.3	 M-Series G-II PCM identification

NOTICE!
The information contained in this manual is only for use with the  
X30, X45 Plus or M-Series G-II PCM.

Please refer to the M-Series service manual at www.proheat.com for 
additional information.

Figure 2-3. G-II PCM identification.

7 PIN 
DATALINK
CONNECTOR

STATUS
INDICATOR
LIGHT
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Welcome to the Proheat Datalink 7 connection and update instructions.
Datalink 7 allows trained personnel to:
•	 Read heater information
•	 Monitor heater inputs and outputs
•	 Monitor heater diagnostic trouble codes
•	 Update firmware and software
•	 Save heater information to a file
Minimum Computer requirements to run Datalink 7 are:
•	 1 GHz processor or higher
•	 Microsoft Windows
•	 USB 1.1 or higher
•	 250 MB of disk space
If you are currently a Datalink user skip to section 5.6 now.

	 3	 Introduction

Getting started, acquiring the correct cabling
If you use a combination of Proheat products — X30/X45 Plus/M-Series 
G-II PCM. Order Datalink kit # PK0072. This kit contains everything you will 
need to use Datalink 7 on all our current Proheat products.
If you only use X30 heaters, then you will need Datalink kit # PK3019 which 
includes X30 and J1939 cables.
If you only use X45 Plus heaters, you can purchase a USB A to B desktop 
printer cable locally.
If you only use M-Series heaters with G-II PCMs then you’ll only require the 
Datalink kit # PK0064 G-II PCM Datalink USB cable.
The Datalink software required can be downloaded from www.proheat.com
Connection is simple by following the heater model specific diagrams 
(figure 3-2, figure 3-3, and figure 3-4).

3.0.1  

NOTE
Be prepared, you may not be able to connect the J1939 cables exactly  
as shown. You may have to remove the green/blue wedge lock of the 
Deutsch plug to allow proper connection.

Figure 3-1. Deutsch plug, green/blue wedge lock removal.
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WARNING!
Do not connect the interface cable to the USB port of a PC until the 
device drivers and Datalink7 are completely installed and the computer 
has been re-started.

NOTE
P/N 149418K is a terminating resistor and is a requirement of the network 
at the end of the CAN, Blue is the backbone and Green or Orange is a 
node, look at the 2 position side of the tee connector P/N 149417 and  
you can see the difference in the center.

Triangle is the backbone!
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NOTE
There is only one way to directly connect Datalink to the X30 as shown in 
figure 3-2. There are two kits available to achive this:
1.	 Kit # PK3019 — X30 and J1939 only
2.	Kit # PK0072 — Datalink master kit

	 3.1	 X30 PCM connections
3.1.1 X30 direct connect

X30 PCM

CAN HARNESS BREAKOUT
c/w DATALINK MASTER KIT

DEVICE IXXAT
PROHEAT

HARNESS 3 PIN
DEUTCH TO DB9

TERNINATING RESISTOR J1939

CAN ‘T’

Figure 3-2. X30 Datalink cable kits.
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NOTE
Datalink can also be used when connected to X30 heaters via a J1939 
vehicle CAN drop.
When using the vehicle supplied diagnostic connector a CAN extender is 
required, as shown in figure 3-5.

3.1.2 Vehicle CAN drop connection — X30 only, when 
heater is connected to vehicle network

CAN ONLY
HARNESS

EXISTING CAN
DROP HARNESS

DEVICE IXXAT
PROHEAT

REMOVE TERNINATING
RESISTOR J1939

CAN ‘T’

CAN EXTENDER

X30 PCM

VEHICLE CAN DROP

Figure 3-3. X30 only J1939 vehicle CAN drop connection Datalink cable kit.
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NOTE
There are two different ways to directly connect Datalink to the X45 Plus as 
shown in figure 3-3. There is one kit available for both methods:
1.	 Kit # PK0072 — Datalink master kit
Or purchase a USB A to B desktop printer cable locally

	 3.2	 X45 Plus direct connect

Figure 3-4. X45 Plus Datalink cable kit.

X45 PLUS PCM

X45 PLUS
PCM

HARNESS
CONTROL

USB  A TO USB B CABLE

IXATT  USB TO
CAN INTERFACE

CAN CABLE

HARNESS CAN EXTENDER

CAN ‘T’

TERMINATING RESISTOR J1939
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NOTE
There are two different ways to directly connect Datalink to the M-Series 
G-II PCM as shown in figure 3-4. 
1.	 Kit # PK0072 — Datalink master kit
2.	Kit # PK0064 — M-Series USB cable direct from PCM to computer  
	 Note: PK0064 is not included in the Datalink master kit PK0072

	 3.3	 M-Series G-II PCM direct connect 

Figure 3-5. M-Series G-II PCM Datalink cable kits.

M-SERIES G-II PCM

METRPACK
TO 3 PIN

DEUTSCH

USB B TO
M-SERIES G-II PCM
HARNESS PK0064

IXXAT
INTERFACE

PROHEAT

HARNESS CAN EXTENDER

CAN ‘T’

HARNESS 3 PIN
DEUTCH TO DB9

CAN TERMINATING
RESISTOR J1939
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Connection method 1 only as figure below.

1.	 Connect battery power to the G-II PCM first.

2.	 Wait for 5 seconds. G-II Status light will flash Green twice.

3.	 Connect the PCM side of the diagnostic cable to the 7-pin diagnostic 
port of the G-II PCM. 

4.	 Connect the USB side of the diagnostic cable to a USB port of a 
computer with Datalink 7 installed. See picture below.

1.	 Disconnect the diagnostic cable from the computer.

2.	 Disconnect battery power from PCM.

3.	 Wait for 20 seconds.

4.	 Reconnect battery power to PCM.

5.	 Wait for 5 seconds. G-II Status Light will flash Green twice.

6.	 Reconnect the diagnostic cable to the computer.

	 3.4	 M-Series Datalink USB power 
		  and connection order

NOTE
If the diagnostic cable is connected before battery power is applied the 
PCM will go into Lock out mode (the Status Light will be flashing alternating 
RED then GREEN). which prevents the heater from working. To unlock the 
G-II PCM, follow these steps:

Figure 3-6. M-Series connection method #1.

POWER (+-)
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NOTE
Datalink can also be used when connected to X30, X45 Plus or M-Series  
G-II PCM heaters via a J1939 OBD vehicle connection.
When using the vehicle supplied diagnostic connector a harness  
(kit # PK0319 ) is required, as shown in figure 3-7.

	 3.5	 J1939 vehicle connection 

IXXAT
INTERFACE

PROHEAT

HARNESS 3 PIN
DEUTCH TO DB9

CAN ‘T’

CAN TERMINATING
RESISTOR J1939

J1939 OBD  VEHICLE CONNECTION
 HARNESS PK0319

3.5.1 OBD connection — X30, X45 Plus, or M-Series G-II 
PCM, when heater is connected to vehicle network

Figure 3-7. J1939 OBD vehicle connection Datalink cable kit.
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Datalink 7 is provided with a software installer to guide a user through the 
installation process.

Please uninstall any previous version of Datalink 7 using the add/remove 
programs option in windows.

	 4	 Installing Datalink 7

WARNING!
Do not connect the interface cable to the USB port of a PC until the device 
drivers and Datalink 7 are completely installed and the computer has 
been restarted.

Go to www.proheat.com and download the latest version of Datalink 7. 
Save it to your Desktop. Open the saved Zip file and extract the Zip file to 
you desktop.

The installer must be run as an administrator. To do so, right click on the 
installer file and select Run as administrator from the popup menu (see 
figure 4-1 below).

	 4.1	 Launching the installer

Figure 4-1. File popup menu.
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The Datalink 7 installer successively displays four setup dialogs.

	 4.2	 Setup dialogs

4.2.1 Setup complete dialog
The Setup Complete dialog is displayed when the installation has 
completed. Select the option to restart the computer and press the Finish 
button to close the installer. The computer can be restarted at a later time, 
but it must be restarted before Datalink 7 can be used.

If required please restart your computer.

Figure 4-2. Setup complete dialog.
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	 5	 Using Datalink 7

Datalink 7 is started by double-clicking on the desktop icon (shown left)  
or by selecting Datalink 7 from the: Windows | Start | Programs | 
Proheat menu.

Once it has completed its internal initialization, Datalink 7 will display the 
Workspace window.

Upon start-up, Datalink 7 automatically launches a background program.

Once PCM has been detected, double-click on the Proheat PCM 1.

	 5.1	 Starting Datalink 7

	 5.2 	 PCM detection

NOTE
Throughout this manual you will see generic images. Each heater has its 
own layout and showing all of them is beyond the scope of this manual. 
All heaters screens are similar.

Figure 5-2. Datalink 7 Workspace window.

Figure 5-3. Datalink 7 Workspace window with a PCM detected.

Figure 5-1. 
Datalink 7 icon.
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Monitoring PCM presence
If communication between Datalink 7 and a PCM is suddenly lost, then 
Datalink 7 draws red crosses over its interface and node icon. If Datalink 7 
sees the PCM again, the red crosses disappear.

5.3.1  

To open and read a PCM, select it from the Workspace window and then 
press the tool bar Read button. You can also double-click on its name 
from the Workspace window.

	 5.3 	 Detecting, opening and reading 
		  a PCM

Database error message
If the Datalink 7 software is older than the PCM firmware or the Datalink 7 
software cannot find a database file that matches the PCM software part 
number and revision, then it displays an error message that will be similar 
to the one shown below.  

5.3.2  

Visit www.proheat.com to download the 
latest version of Datalink 7. Then Read 
PCM again.

Figure 5-4. Lost PCM.

Figure 5-5. Database search error message.
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New firmware
If the firmware in the PCM is older than the Datalink 7 software you will 
have the option to update it during the initial Reading of the PCM. You can 
choose not to update the PCM firmware by selecting “No”.

The heater must be connected to an active vehicle network first, then 
powered up.

Selecting “Yes” will update the firmware.

When the Firmware update is finished please follow the on screen instructions.

5.3.3

NOTICE!
Do not have the PCM connected to a computer when connecting power 
to the heater. 

Figure 5-6.

Figure 5-8.

Figure 5-7.
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After Datalink 7 has completed reading the content of a PCM, it creates a 
new window and displays the PCM information tab. A number of additional 
tabs are available each containing different pages for viewing PCM data. 

	 5.4 	 PCM window

The network source address and network speed are set at power up, if the 
heater is connected to a Computer it may get the wrong information and 
not work with the vehicle network. To reset disconnect the heater from the 
computer and connect to the vehicle network and then reboot PCM.

After opening the PCM, Datalink 7 starts reading the content of the PCM 
memory while showing the following progress bar.

Figure 5-10. PCM window.

Figure 5-9. Reading progress bar.
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Each PCM window is divided into five pages. Each page can be opened 
by selecting its corresponding Tab. The table below summarizes the 
content of the different PCM window pages seen when Datalink 7 is 
connected to a PCM.

	 5.5  	 PCM pages

Page Content Summary

Information Various part and serial numbers

Signals Real time monitoring of input and output signals

Diagnostics Real time monitoring of all diagnostic trouble code status

Events Viewing of PCM event log, statistics and meters

Table 5-1. PCM window pages.

Information page
The information page displays part and version information about the PCM 
connected to Datalink 7. These items are read-only and cannot be edited.

5.5.1

Figure 5-11. PCM information page.
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Settings page
The Settings page can be used to change options, timing, and

sensor thresholds.

5.5.2

Figure 5-12. PCM Settings page.
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Signals page
The Signals page allows you to monitor PCM inputs, outputs and variables. 
Datalink 7 continuously refreshes the data in order to present it in real time. 

Diagnostics page
The Diagnostics page provides functions that you can use to monitor the 
status of all diagnostic trouble codes. When a particular code is active, its 
corresponding status LED turns red. In the example below, trouble Codes 
5, 6, 7, 12 & 17 are active.

5.5.3

5.5.4

Figure 5-13. Signals page.

Figure 5-14. Diagnostics page.
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Event logging page
The Event logging page displays the event log and meter information 
recorded by the PCM into its memory. To display the content of the event 
log, press the Read Log button once. While reading the event log, the 
PCM displays the following progress bar.

Once the event log is entirely read, it is displayed in the Logging page. The 
event log contains up to 1024 records and each record holds 20 parameters. 
To navigate the event log and view all records and parameters, use the 
scroll bars.

5.5.5

5.5.5.1 – Time and date display

The time and date associated with each record can be displayed using the 
original event GMT stamp or translated to local time and date using your 
computer time zone settings. To change time and date display, use the 
Time and Date radio buttons. Changing time and date display does not 
affect the event log stored into the PCM.

Figure 5-15. Event logging reading progress bar.

Figure 5-16. Event logging page.
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5.5.5.2 – Log file sample

As you can see on the highlighted rows is an example of a heater log file. 
The log file is presented with the newest record always at the top and the 
oldest record at the bottom. Reading from left to right the event that 
triggered the log record Line 591 on 18-FEB-2014 at 19:57:51 was a 
CAN SUPPLEMENTAL SW ON event, the heater was in the OFF Mode 
and OFF State. At the time of the event record the Coolant Temp was 
138°F and the voltage was 28.0 V. The other data fields show what was 
recorded at the time of the event.

The heater now entered the PreCheck then the PreIgnition then finally the 
Ignition states (these are non recording events) During this time a 
temperature and fault check is done, then the igniter is turned on and the 
blower motor speed is ramped up.

The next record up in the log on Line 590 on 18-FEB-2014 at 19:57:54 
is the HEATING CYCLE ON event, the heater was in the Supplemental 
mode and the Ignition state. At the time of the event record the Coolant 

Figure 5-18. Example log file screen.

Figure 5-17. Time and date display.
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Temp was 136°F and the voltage was 27.4 V The other data fields show 
what was recorded at the time of the event.

The heater now entered the Run state (this is a non recording event) until 
the next recorded event.

The next record up in the log on Line 591 on 18-FEB-2014 at 20:03:26 
is the HEATING CYCLE OFF event, the heater was in the Supplemental 
mode and the Run state. At the time of the event record the Coolant Temp 
was 186°F and the voltage was 27.8 V The other data fields show what 
was recorded at the time of the event.

5.5.5.3 – Event log statistics

The Statistics page shows the historical count of Diagnostic Codes and 
Event that are found in the 1024 events in the log.

5.5.5.4 – Counters

The Counters page displays the historical hour meters and cycle counts.

Figure 5-19. Event log statistics. 

Figure 5-20. Counters.
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By clicking the UPDATE tab in the toolbar, you will be offered a number of 
templated configurations for a number of specific OEM demands.

The description should help in your choice of the appropriate application.

Once configuration has been changed:

1.	 Disconnect the diagnostic cable from the computer.

2.	 Disconnect battery power from the PCM.

3.	 Connect heater CAN to an active J1939 vehicle network if used

4.	 Wait for 20 seconds.

5.	 Reconnect battery power to PCM.

6.	 Wait for 5 seconds.

7.	 Reconnect the diagnostic cable to the computer and read the PCM  
to verify the configuration number is now correct under the 
information tab. 

	 5.6 	 Update configuration

Figure 5-22.

Figure 5-21.
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	 6	 Datalink 7 Menu and 
		  Tool Bars

The menu bar is composed of 6 drop-down menus: File – View – Control 
Menu – Tools, Window and Help. The following paragraphs describe all 
drop-down menus.

	 6.1	 The menu bar

File menu
The File menu contains the file Open and Save commands.

6.1.1

Command Function Shortcut

Open… Open a complete PCM document from disk
Useful to read saved PCM data while Datalink 7 
is not connected to PCM

CTRL+O

Save Save current PCM information to disk for further 
analysis or archive

CTRL+S

Exit Exit Datalink 7

Table 6-1. File menu commands.

Figure 6-1. Menu bar.

Figure 6-2. File menu.
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View menu
The View menu contains options to show/hide menu bars.

Control Module menu
The Control Module menu contains the PCM Read and update commands.

6.1.2

6.1.3

Command Function

Toolbar Hide or shows the toolbar

Status bar Hide or shows the status bar

Command Function

Read Read the content of a PCM

Write This function is not used

Update See the firmware page for more information

Table 6-2. View menu commands.

Table 6-3. ECU menu commands.

Figure 6-3. View menu.

Figure 6-4. Control module menu.
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Tools menu
The Tools menu contains optional settings.

Windows menu
The Windows menu contains display settings.

6.1.4

6.1.5

Command Function

Users This function is not used

Privilege Opens the access privilege window. Note: privilege 
codes can be obtained form Proheat product support

Communication 
interface

Opens the communication interface window

Options -> Chooses between imperial and metric units and set  
the maximum refresh rate

Table 6-4. Tools menu commands.

Figure 6-5. Tools menu.

Figure 6-6. Windows menu.
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Help menu
The Help menu provides copyright and version information through the 
About... command.  Also, any file found in the Help sub-folder will be listed 
into the Help menu.

6.1.6

Command Function

About Open the copyright and version information window

Read me Open the readme.txt file

Table 6-5. Help menu items.

Figure 6-7. Help menu.



6-5EN

Command Function

Open Open a saved file

Import This function is not used

Save Save log to a file

Read Read PCM

Write This function is not used

Update Update firmware. See the firmware page for more 
information

Workspace Shows the Workspace window

M-Series PCM Shows the M-Series PCM window

Table 6-6. Toolbar commands.

The toolbar provides shortcuts to the most commonly used commands. 
The table below shows the toolbar commands.

	 6.2	 The toolbar

Figure 6-8. The toolbar.
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